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Storing and
Sharing in
the Cloud

•• Learn useful Google Drive techniques for the classroom
•• Learn how to enhance and refine Google Drive documents
•• Learn how to use Google Drive to improve the way you teach

T

he work you and your students create in the classroom can be placed
online (in the cloud) using Google Drive so you can access it anytime
or anywhere. This will allow you to collaborate more easily and get and
give feedback in an efficient manner. Ultimately, it will also be a very useful tool for allowing students to be self-paced in your classroom.
One of the most used cloud-based software programs now in classrooms is Google Drive (formerly Google Docs). If your school purchased
it, the suite is also known as Google Apps for Education. Google Drive
is essentially a slightly simpler version of Microsoft’s Office program.
Since it is in the cloud, it is updated all the time and does not require
any new purchases (i.e., you will continually have access to the latest
updates for free).
Using the vernacular of Project RED as discussed in Chapter 1, Google
Drive’s use in the classroom can be either a first-order change or a secondorder change. Since it has the full suite of documents, Presentations (similar
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to PowerPoints), spreadsheets, and so on, it can be a very convenient platform for students to turn in work. As with Microsoft, you and your students can also organize your work into folders. All of these are first-order
changes that you can easily implement in your classroom.
But Google Drive also allows for second-order changes. You can have
students working together from different classes or, for that matter,
schools or even countries. You can use Google Drive to create formative
assessment tests and quickly ascertain if a student should do some
refreshment work on assignments. The list of potential second-order
changes is limited only to you and your PLC’s imagination. You can even
use Google Drive to collaborate with other educators far from the doors
of your school.
So let’s go! The Google Drive
suite allows you to create and store
The list of potential second-order changes is
word documents, called Google
limited only to you and your PLC’s imaginaDocs; Presentations (which is
tion when using Google Drive. You can even
Google’s word for PowerPoints);
use Google Drive to collaborate with other
spreadsheets; questionnaires, called
educators far from the doors of your school.
Forms; and drawings (which
Microsoft calls Paint). You can also
add a host of other items such as WeVideo, which allows you to virtually
collaborate with others on what Microsoft would call Movie Maker.
Please note that Google Drive recently updated its look, and this book
reflects that change. If you are looking at the older version, go to the round
gear in the upper right hand side, hit “Settings,” and then “Experience the
New Drive.”

GOOGLE DRIVE TECHNIQUES FOR THE CLASSROOM
Uploading
Google Drive allows users to upload files from other applications such
as Microsoft (Word docs, Excel Spreadsheets, PowerPoints). If you use
the free Google Drive associated with your Gmail, you will be given 15
gigabytes of space. How big is this? I have all my files for ten classes, all
of my personal data, and even the manuscript of this book and have
used only 12 percent of my total allotted space. This is because anything
started from scratch in Google Drive does not count against your total
space allotment. Since you can upload an entire course folder in just a
few minutes, it will not take much time to put everything you need in
the cloud. Then you will be able to access all of your work from your
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smartphone, tablet, or any computer in the world. No longer will you
need to drag your computer home with you, keep track of several flash
drives, or worry about something important being left behind on your
desktop.

Copyright Corwin

•• To upload a file or folder, go to the down arrow on the upper left
side of Google Drive and look for the “New” button. Once you tap
on it, you will see “File upload” and “Folder upload.” Then you will
need to find the item on your laptop that you want to upload.
•• Once you have found it, click on it and push upload. You may want
to convert your Microsoft documents to Google ones, in which case
you have to go to the gear symbol at the top right.
•• A new screen will appear, and you can click on the option you want,
such as one that allows you to convert.

Google Drive Folders
You can use Google Drive Folders to have students submit completed
assignments online as soon as they are done rather than have students
wait to hand them to you in class. As with any new endeavor, there will be
some adjustment phobia. But very quickly your students will prefer the
online method for turning in work. There are several time-saving benefits
to submitting work online for both you and your students. You and their
parents will appreciate students’ newfound organization. Using the search
bar in their Google Drive accounts, students can find anything instantaneously. Students can easily share work with their peers without having to

Visit http://bit.ly/digitalclassroomteacherguide to access live links.
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make copies. You will no longer have to waste time handing back work
and instead can concentrate on grading in real time. If an assignment is
due Tuesday at 10:00 a.m., I try to start grading early Tuesday morning or
on Monday night so that most of the students have their graded work
returned to them before it is officially due. If I add comments to a student’s
file in Google Drive, the program will let the student know by showing the
title of the file in bold font. This is how my students know that their work
has been graded. Since my students have come to expect my quick grading
turnarounds, when they enter class at 10:00 a.m., some will ask why their
work has not yet been graded. You may not want to put yourself under
that kind of pressure, but you will come to appreciate your students’ seeking out quick feedback, facilitating their ability to improve their work
almost in real time.
The first thing you will want your students to do is to create a folder for
your class on their devices. Folders are no different from the ones your students have in their backpacks, except these are digital. Just as your students
have folders or interactive notebooks, you are going to help them do
the same in Google Drive. Have your
students go to Google Drive and create an account. If they already have
Gmail, then they just need to log in
in with their Gmail password.
•• Go to the upper left side and to
the red “New” symbol and then
to “folder.” If you are using the
older version, you will see “Create”
instead.
•• A box will appear where you can
give the folder a title. I would
suggest having the students label
the folder with the name of your
course so that everyone has, for
example, “Biology 101” in their
Google Drive.
•• Then have the students click on
the folder so it turns red. Then go
to the “New” button and to
“folder” and create a subfolder
that is named for the first unit
you are covering in your course.
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Now let’s go to a simple document. You are going to create your first
document or instruct your students in doing the same.
•• To begin, click on the folder where you want it to go to so it turns red.
Then go to “Create,” and then go to “Document” and click on it. In
the middle of your screen, a document will appear looking every bit
the same as what you are used to in Microsoft’s Word program, but
now you are in the cloud.
•• If you forget to click on the appropriate folder, then just right click
on the assignment, go to “Move,” and then navigate to the correct
folder.
•• Next, when you open up a document, it will ask for a title. I always
tell my students to name it first with the number for the period of
the class they are taking with me, then a space, their name, a space,
and finally the name of the assignment we are working on in class.
For example, “2 Halla Questions on Homer.” If you are an elementary teacher, you might have the date go before your name. When
files are labeled in this manner, a teacher is able to see the documents students have shared in an organized fashion, making it
much easier to enter into a grade book.

•• Now run your cursor over the icons starting on the left at the top of
the page (see image above). The first symbol will say “Print” and the
second, “Undo,” and so on.
•• An icon with which you may be unfamiliar is the hyperlink symbol, which looks like a link from a chain. Click on the hyperlink
icon when you want to insert a hyperlink (URL) from a web page
onto an image or word. To do this, go to the web page, drag your
cursor over the URL, and then hit the “Control” and “C” buttons
(that is the copy command). Then go back to the hyperlink symbol on your document page and press “Control” and “V” (that is
the paste command) on your keyboard, and it will be pasted into
the space.
•• You can also instantly undo something by clicking forward or back.
wards on the arrows

Visit http://bit.ly/digitalclassroomteacherguide to access live links.
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Everything else on that line will be
familiar to you from the type of text you
want, to whether you want to bold letters,
or underline them, center them, and so
on. One change from a Word document is
that if you want to have a font size that is
not normal, such as 9.5, just click on the
font number, delete what is there, and
type it in.
Another great feature of Google Drive
documents can be found under “Tools” >
“Research.” You will see a pop-up window on the right side of the page where
you can then input your topic into the
research window. If you hover your
mouse over the topic, you can choose to
preview, insert a link in your document,
or even add a citation at the foot of the
page. Underneath your research window,
you can choose the style of citation you
need (MLA, APA, or Chicago). When you
click on the research window, you can
choose to search specifically for images,
dictionary, scholar, and more.

Using the Cloud to Stem Plagiarism
Unfortunately some students will not be able to resist the temptation to
plagiarize from Internet sources and copy from peers since it is so easy.
Therefore, you need to be proactive and thwart plagiarism and copying
early on. The best way to do this is to educate students about proper digital citizenship by showing them how to cite sources correctly. It is also
important to let students know that you will be investigating suspicious
passages from their work. They should quickly get the message that they
won’t be able to get away with not citing their sources.
Unfortunately some students will not be able
to resist the temptation to plagiarize from
Internet sources and copy from peers since it
is so easy. Therefore, you need to be proactive
and thwart plagiarism and copying early on.

•• If you see a series of words that
are too good to be true, copy
and paste them into a search
engine. If the student copied the
passage, the source will appear
in your search.

Copyright Corwin

Storing and Sharing in the Cloud

•• Once your students have all turned in their work, you can put a
questionable (as in possibly copied) stem in the Google Drive search
engine at the top of the page. If any other student’s work includes
the same line, that file will appear.
•• If you are working on the assignment with other teachers, send them
the same string of words and have them also use their class folder’s
Google Drive search engine where it says “Search Drive.” Usually if
you catch students doing this early, they will be freaked out and be
less like to plagiarize later.
•• You can also go to “File” and then “Revision History” and click on
earlier versions of the document. The earlier versions will list the
time that it was created and if there is only one, you can assume it
was either uploaded (something I discourage in my class) or copied and pasted. Usually the students make some mistake such as
pasting in one version with the other student’s name. Since you
can see all the changes, all you need to say is “I see you deleted
“Joey’s name at 1:13 a.m.” Of course, administering assessments
on a regular basis will tell you who is doing the work. You can also
use “Revision History” to look at your own earlier versions of a
document in case you would like to return to a previous version or
see the changes your colleague made on a document you are collaborating on.

REFINING GOOGLE DRIVE DOCUMENTS
Inserting Images
Inserting images into documents adds a nice touch. It is my belief that
having an image at the top of an assignment adds another important
dimension to it. Since many of us think in images, seeing one at the top of
an assignment will better connect the information for students in their
memories.

Visit http://bit.ly/digitalclassroomteacherguide to access live links.
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•• To insert an image, go to the page and hit “Insert” and then “Image.”
•• If you click on the first symbol for adding an image, it will bring up
a new window where you can search for a saved image. Additionally,
any time you run your cursor over an item, a description of it will
pop up.
•• But since you are in the cloud, you could also click on “By URL” and
add in a URL from a web image. This will save you the time of
downloading and uploading the image. To get the image URL, just
right click on the picture and it will say “save image address” or
“save image URL.”
•• You can use EasyBib (see Chapter 1) to create citations for images.
There are also sites such as Creative Commons (Google it!) that
allow you to use their images without having to receive permission
for items that might be made public, provided you follow the guidelines of the site (such as not using the image for commercial gain).

Drawing
In addition to documents, you can also create drawings. To do this go to
the “Create” tab at the top of the Google Drive suite, making sure you are
in the correct folder by clicking on it so it changes colors. Then go to the
drop down called “Drawing.” Essentially this program is the same as
Microsoft’s Paint. There are any number of reasons you might want to use
this. You or your students could diagram a sentence. You could upload a
map (“Insert” > “image”) into a document and then label the map or label
parts of a flower for biology.
•• As with most of the other applications in this chapter, go to the
“Insert” button, then “Line” and you will see the “Scribble” button,
which is the one you will want to use most often. Click on it and
start dragging your cursor about your image.
•• Once you are done scribbling, click on the pencil image

,

which won’t appear until you draw your first line. Clicking on the
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pencil image will allow you to change the color of the line. To alter
the width of the line, click on the icon with three lines as seen above.
By going to “Insert” and “Line,” you can get a line that you can
draw from one item to another. Whatever key you want to use, just
hover your mouse over it, and a word will pop up telling what it is
used for. The best way to learn at this point is just to try and to make
mistakes.
,
•• You can write on your image by clicking on the text box
dragging out a corner, and writing inside the box.

•• From inside a document, you can create a drawing by going to
“Insert” and then “Drawing.” When you are done, press “Save and
Close” and the drawing will be inserted into the document.

Sharing Google Drive Files With Students and Colleagues
There are many great advantages to using Google Drive. Perhaps the
greatest one is that all changes are saved instantly. Secondly, you can
share your files, collectively or on a case-by-case basis, with up to ninetynine others who can collaborate instantly. The first time your students
collaborate they will find it odd to see other students’ cursors (their
names will appear beside them) inside their document, but they will soon
learn to maneuver around these. If you have worked collaboratively via
e-mail in the past, consider how many times you or your students have
e-mailed a document back and forth to each other until it is complete.
With Google Drive, you need never do this again. Now you can insert
comments (“Insert” > “Comment”) or even just make corrections that collaborators can view through Revision History without ever having to
e-mail anything.
Visit http://bit.ly/digitalclassroomteacherguide to access live links.

• 51

52

•

PART I: The Teacher as Leader of the Digital Classroom

There are two primary ways
you can share documents with colleagues and students. For example,
you might want to share with your
students a document that contains
instructions for an assignment. You
can give students the URL for the
Google Drive document by pasting the URL into a platform such as
Blackboard or Moodle.
Then instruct students to take the following steps.
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Perhaps the greatest advantage of working in
the cloud is that all changes are saved instantly.
Secondly, you can share your files, collectively
or on a case-by-case basis, with up to ninetynine others who can collaborate instantly.

•• Click on the link to open the Google Drive document.
•• Go to “File” and “Make a copy.”
•• Rename the document with their last name and the name of the
assignment.
•• Close out of the document.
•• Go to their Google Drive home page and find the “Recent” link at
the bottom left of their list of documents.
•• From the list of recent documents, drag the new assignment document into one of the folders on the left.
•• Go into the folder and open the assignment.
•• Now students can edit the document with their own work.
•• To share the work with you (or their fellow students), go to the
upper right side to the blue “Share” button. Click on the share button and type in the teacher’s or the student’s Google e-mail address.
•• There are levels of sharing (Can Edit, Can Comment, and Can View).
Have the students select the appropriate level of sharing for each
given situation. Generally the teacher wants to have the student set
it for “Can Edit.”

Storing and Sharing in the Cloud

•• On the lower left side of your Google Drive home page, you will see
a folder called “Incoming.” Those of you using the older Google
Drive version will see “Shared.” Click on this, and you will see all
the documents that people have shared with you.
•• If you use my naming format, the files will be organized by class and
ready for you to grade.
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This is a suggested procedure for grading student assignments.
•• In the older version of Google Drive, you will see a blank check box.
Once you have clicked on each corrected assignment, right click on
one of them and all will be removed. In the newer version of Google
Drive, you will just have to right click on each item and press
“remove” as you finish each item.
•• The files are no longer in your Google Drive account, but your students will still see that they have shared the item with you. They can
go to their “Share” button and look at who has access to the item. So
if you want to have your students re-submit something after you
have taken it out of your “Incoming” folder, have them go to the
“Share” button and click on the “X” beside your name, which will
delete it. After that they can resubmit your name to be shared and it
will reappear in your “Incoming” folder.
•• If you would rather keep the assignments after you have commented
on them, I suggest that you create a folder for each assignment.
•• Go to “Create” > “Folder” > (name the folder) > “Create.”
•• The same principle then applies. If you check the box after commenting on each file, you can then move the checked files all at once
into another folder, in this case the folder specified for that particular assignment. Right click on one of the checked files, select “Move
to” > select the correct folder > “Move.”
•• If a student has made corrections on his or her assignment based on
your feedback, the name of the file will be bolded, letting you know
that it is time for you to look at the work again.
•• Once you have made corrections on a student’s work, right click on
the line in your incoming list and then hit the “Remove” button.
Another use for a Google Drive document is to have your students
share their first draft of a paper with you or with fellow students for
Visit http://bit.ly/digitalclassroomteacherguide to access live links.
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feedback. Once the draft has been shared, those individuals may comment
on the document

Copyright Corwin

•• The comment icon looks like a speech bubble

. When you

click on the comment button, a side screen will appear on the right
side of the page that will allow you to insert comments.
•• Alternatively you can go to the “Insert” tab and then to “comment.”
Now your students can see your comments on each section that needs
work. If you are teaching a writing class, you can live edit student
papers with having to walk around the room. This might be a difficult
concept to grasp at first, but remember that any file in Google Drive is
simply a web page. So when you and your student share a file, you are
both in the same document. Students can rework the draft, click on
your comment, press “resolve” and the comment will then be deleted.
Since it is a web page, you also will never need to carry a flash drive
around as all you need is an Internet connection and a browser.

BEYOND DOCUMENTS
Splitting Your Screen
If you want to grade assignments and immediately put them in your
gradebook, then you will want to split your screen. On many computers
all you need to do is to open up two Internet windows (or one browser
window and one Google Drive document).
•• Go to the bottom of the screen, right click and press on the line that
says “vertically split your screen.”
•• Now go to the bottom of your screen and right click on your mouse pad
and hit the part of the screen that says split vertically or horizontally.
•• If you want to change the size of each half so that one has one-third
and the other has two-thirds, then put your cursor on the edge of
one side until an arrow appears and then draw the side to make it
larger or smaller. On an Apple laptop, this is the only way to split a
screen short of purchasing an online app to do so.

Presentations
The next item under documents is “Presentation.” I sometimes use several
slides at a time for when I flip my classes (see Chapter 5). What I love about
these presentation slides is that I can give my students the URL for each
presentation and, if I later edit the slides, I do not have to give them an

Storing and Sharing in the Cloud

Copyright Corwin

updated version or a different URL since the original
URL will lead to the updated version. Best of all, one
can include video from YouTube very easily within
the presentation slides. If you do share YouTube videos with your students, make sure you include
proper citations and get permission if you are making the Presentation public.
When I started using Google Drive, I first
uploaded all of my PowerPoints. Working on the
PowerPoints within Google Drive is incredibly
easy.
•• To upload a Microsoft PowerPoint (or any
other item), go to the upper left and tap on the
word “New” and then “File upload or “Folder
upload.”
•• If you are starting from scratch, when you first
open the Presentation file, you will be
prompted to select a background.
•• Go to the “Insert” tab on the upper
left side. You will see a text box for
inserting lettering.
•• You can also insert word art, a table,
an image, lines, shapes, animations,
and more. You will want to remind
your students to properly cite whatever they use and to get appropriate
permissions for anything they make
public.
•• If you want to insert a video, click
on “Video” and you will be taken to
a YouTube search engine. Write the
title in the box, press “Enter,” and
your video will appear. Double click
on it, and it will be added to your
Presentation. If you put your cursor
on the end, you can stretch or shrink
the image.
•• To insert new slides in a Presentation,
click on the “Slide” menu option
next to “Insert.” You will be able to
choose which type of slide you
would like to insert.
Visit http://bit.ly/digitalclassroomteacherguide to access live links.
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The suggestions offered in this chapter are a good way to start implementing second-order change in your classroom. Once you become familiar with the basics, you will find that there is a lot more you can do that
extends beyond the tools listed in this book.
As you can probably tell, my style of teaching is hands on rather than
straight lecture, as I believe that students learn more by muddying their
hands than by passively listening. The best way to create and view Google
Drive Presentations is on a laptop or desktop computer. Although you
can see most of the applications on a smartphone or tablet, you cannot
manipulate everything as you can on the laptop. But, in a year or so,
Google Drive will likely be upgraded so that use on tablets will be easier.
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How to Use Google Forms
Every year I have to collect student and parent e-mail addresses for our
gradebooks. I used to pass around a sheet of paper and then struggle trying
to decipher everyone’s handwriting. Other times, we want to collect
answers from students after they have watched a video. Now, I accomplish
these tasks easily and painlessly by using Google Forms.
•• Go to New > More > Google Forms.
•• You will be prompted to enter a file title and to select a background.
•• You will then be prompted to enter your first question. I always start
with the LAST name (which I emphasize with capitals to catch my
students’ attention).
•• Beside “Question Type,” you would click on “Text” in this case—
although there are many other options. Depending on the type of
question you choose, your screen will change.
•• Then decide if you want to make it a required response by checking
the box beside “Required” or “Optional.”
•• Continue to add questions until you are done.
•• At the top of the page look for the words “View Live Form.” Click
on that link, and then copy the URL and send it to your students.

Storing and Sharing in the Cloud
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Look at the image below, which illustrates a completed quiz. Very
quickly you can eyeball it to see if your pupils put down all of the correct
answers. This is a very useful form to create when you want to collect
information from students at the beginning of the year. I use it as a quick
way to get parent e-mails, phone numbers, and so forth.

Templates
Instead of creating your own Google Forms from scratch, as a beginner,
you might want to search for forms that have been created by others. There

Visit http://bit.ly/digitalclassroomteacherguide to access live links.
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are many, many templates for documents, Presentations, forms, drawings,
and spreadsheets. To find them, go to a search engine and type “Google
docs templates” (see image above). When you find a template you want to
use, simply hit the “Use this template” button and it will open that particular Google Drive application. You will then be able to start editing the
template to fit your particular needs. Once you have finished editing, go
into your Google Drive account and click on “Recent” on the lower left,
and you will see the new template saved.
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Google Translate
One of the classes I teach is a mainstreamed World History class that has
been combined with English Speakers of Other Languages. Almost half of
the students have been in the United States for two or fewer years. For
those students, it sometimes helps to translate documents. Think about
when you are trying to help a student to learn how to write. The key is
writing, not knowing the language. Likewise, students who have just
come to the United States might want to see a full translation of your entire
project. To translate a document, simply go to “Tools” and “Translate
document.” It will not be perfect, but it will help your students immeasurably. You can find even more languages by going to Google Translate.

Math Symbols
If you look closely at the symbols at the top of a Google Drive document,
you will notice no math symbols. But you can pop them in very quickly by
going to “Insert” and then to “Equation.” Now you can add equations
very easily.

Adding Applications to Your Google Drive Account
Another wonderful advantage of Google Drive is that you can add apps to
it. For example, WeVideo is a cloud-based app that several people can
work on simultaneously to create a video. WeVideo allows you to mix
video with pictures, sounds, graphics, and words. The great thing about
WeVideo is that it is compatible with both Microsoft-based computers as
well as Apple devices.
There are plenty of other apps that you can add to your Google
Drive by clicking on “New” > “More” and then looking for apps that
you think might be helpful to you in your classroom. For most apps, you
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should be able to find tutorials on YouTube that will help you get started
with the basics.

Syncing Google Drive With Your Laptop
When people start using the cloud, many worry that their files are not
safe. Even though everyone who accesses the Internet from a computer is
susceptible to viruses that could destroy all of their documents, most people still want their work saved on their laptops. If this is a concern of
yours, you can choose to sync your Google Drive files with your computer or computers. If Google Drive is synced, any work edited in the
cloud version of Google Drive will also show on your computer and any
work done on your computer (on those synced files) will also appear on
Google Drive.
•• To sync your cloud version of Google Drive to a saved document on
your laptop, go to the top right side of your Google Drive main page
and tap on the round gear symbol, which is your settings tab.
•• You will then see “Download Google Drive.” Go to the downloaded
program, click on it, and let it run the program.
•• Go to the round gear on the upper right side of your folder page, tap
it and “Settings” > “General” > “Offline,” and check the box to start
syncing with your laptop.
•• It will differ depending on your computer, but somewhere on the
desktop you will see the Google Drive icon. Clicking on it will allow
you to see your files.
Visit http://bit.ly/digitalclassroomteacherguide to access live links.
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•• Now each time you update documents on the cloud, as soon as you
open up your “base” laptop, it will sync with what is online.
One of the nicest parts about adding Google
Drive to your repertoire is the efficiency you will
gain. Grading will never again mean dragging folders home, or losing items. You will save time by adding in grades as you mark the assignments, and you
can have more time to work with your students or
even to relax!
An important ingredient to having students
moving through a course at different paces is grading work almost immediately. This is not as difficult
as it may seem. Some correcting can be done during class so students who
need help can see teacher feedback right away. Given that correcting
work always takes the same amount of time, be it today or next week,
why not mark it right away while it is still fresh in the students’ minds?
In my experience, when students
look at a corrected assignment on a
An important ingredient to having students
paper, they are less likely to look at
moving through a course at different paces is
comments in that medium than on
grading work almost immediately.
a digital copy such as a Google
Drive document. Students, like
most of us, also appreciate timely feedback when the assignment is still
uppermost in their minds. Giving comments a few weeks after work has
been turned in often means a student will be less inclined
to closely study the corrections needed.
Here is the QR code for the links in this chapter.
Alternatively, you can go to http://bit.ly/digitalclassroom
teacherguide

CLASSROOM EXAMPLES
My students have all of their work in files that look like real notebooks, only
digitized. This first-order change allows them access to their work at all times.
No more worries about forgetting work when they move from friend to friend or
even parent to parent. Since work can be instantly shared with me, there is also
no forgotten homework. This means that students can also instantaneously see
my corrections on their assignments and work with me or peers to improve work.
We also use Google Drive documents to work in small groups; but, unlike
traditional classes, we are not limited to just those in the classroom at the
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moment. If it is appropriate, we share the folders with students in other classes.
For example, one year, after the advanced placement exam, a colleague and I
combined our AP US history and AP US government students into a very large
classroom and had juniors and seniors collaborating across grade levels and
with students not even in their same class schedule. Similarly we have also
worked with students from other schools.
What about when your students are writing? Perhaps you know a page that
can help them on the Internet to better learn a concept. Simply insert the link
in your comments and your students will quickly be able to go to your recommended page. Likewise, if you keep a page with all of your assignments on it
and links to them, if a new student comes in midyear, you can make a copy of
the document, amend it, and in short order have all of the assignments for the
new student easily accessible. The key is thinking that differentiating is okay
and that separate pacing may be necessary for the special education, ESOL,
or any other students with unusual situations. If you think about it, using
cloud-based assignments will allow you to let students work at their own pace
and for you to mingle more with each of the students as you explain and reexplain each of the concepts. In my school, we have a built in remediation
period every other day. But because of the self-pacing my students are already
doing, there is no need for the remediation period since it is being done every
class period with the students who need it and there is no need to wait for a
designated time.
In my department, members of the PLC share their folders with one another
and with the administration. No longer do we need to e-mail our administrator
our PLC notes. Instead she just goes in our shared PLC folder and looks at our
work. Likewise, we share our entire class assignments instantly with other PLC
members or even teachers in other schools. This allows for instant collaboration
among teachers. Since Google bolds any document that another person has
worked on, when you open your folder, you instantly know if someone else has
made a change.

EDUCATOR CHALLENGES
Monday Morning Challenge: Commit to uploading a complete folder
of one of your classes into Google Drive. Once you have done this,
promise yourself that you will use only Google Drive for the entire
year for one class. Understand that it will take time to adjust, but the
commitment now will mean you will gain efficiency, and in a year you
will gladly be putting all of your work in the cloud.
Tuesday Morning Challenge: Have your students create a folder for
your class and put all of their work into it on a daily basis. Realize that
Visit http://bit.ly/digitalclassroomteacherguide to access live links.
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some students will need additional help over a period of weeks, but
commit to the challenge and student productivity will greatly improve.
Wednesday Morning Challenge: Give your students a short research
assignment and have them use the Google Drive document research
tool to find and cite information. Have them turn in the assignment
with five or six citations.
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Thursday Morning Challenge: Collect student information such as
home phone numbers and parent e-mails using a Google Drive form.
Now when you need to contact parents, you can access it no matter
where you are.
Friday Morning Challenge: Try collaborating with other teachers on
creating a common PLC assignment. Think of a project you might
want to create, share it with the other members on your team, and have
each of you make additions. Remember, you can insert comments in
the margin to give one another a heads-up as to what you are thinking.
You might even raise the bar and collaborate with members of another
school’s PLC using a Google Hangout and the document. This would
be a second-order change, as you could create an assignment in real
time with educators you would be left to e-mail with at best.
Twitter Hashtag Challenge: Use #individualizelearning to Tweet ways
you are using Google Drive in your classroom. You could share a lesson plan that you have developed on Google Drive by pasting the link
to the file in a Tweet (including the #pacingdigitallearner hashtag) to
ask others for ideas on how you might improve the lesson.

